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8) FINE PRINT (LEGAL DISCLAIMER)........................................................................................................................

1) OVERVIEW

OfficeView is a program that shows the whereabouts of employees at the glance of a 
screen.  Easy to use and install, it will prove useful in any office where people are coming 
and going during the day.  The reception desk can respond quickly without having to make
phone calls or searching for available employees. 

A messaging system allows users to communicate.  For example, a receptionist may send
telephone messages to employees.  An Additional Information screen is available for each
employee.

OfficeView has an easy to read display board.  Employees that sign in are highlighted in 
green (in and available) or in purple (at work, but unavailable).  A simple click of the 
mouse can change someone’s status. Comments may be added in the adjacent remarks 
field.  Users may choose a remark from a list of standard remarks describing the 
employees status, e.g., on vacation until <date>, in a meeting, etc., or they may type a 
customized remark.  Smart keys for times, dates or customized prompts can assist you in 
generating remarks.  

In the 1000-names version, the employee names are grouped into organizational units, 
e.g., divisions.  
 
Optional helpful pop-up hints (yellow background) guide the user.  More detailed help is 
also available from the Help menu. 

OfficeView may be used on a single computer at a reception desk or on a network, in 
which case the employees themselves would make the entries.  The program is available 
in three sizes which will accommodate up to 10, 30 or 1000 names.

A five-names trial version is available for the 10 or 30-names programs.  The trial version 
for the 1000-names program enables three names in three groups to operate.  You must 
register your program to increase the number of names.
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2) STEP BY STEP FOR USERS

Mouse actions refer to the left mouse button only.

Easy Access to Hidden OfficeView Screen
If the application you are working in covers the OfficeView screen, you can quickly flip to it 
by holding down the Alt key and tapping the Tab key until the OfficeView icon is selected.  
Release the Alt key to pop up the OfficeView screen.  Repeat the same procedure to 
return to your original application.

Signing In
To sign in, click in the remarks field beside your name and choose IN from the pop-up list. 
The adjacent remarks field will indicate  IN and the background will change to a green 
color.

You will probably find it useful to have the program automatically start up when you turn 
on your computer.   That is, the program would be included in the Startup group of  your 
computer.  The program would then automatically indicate IN beside your name.  

After signing in, if you do not wish to be disturbed, click on the remarks field beside your 
name and select In But Unavailable from the pop-up list. This remark will appear beside 
your name and the background will turn purple.
If an IN remark remains unchanged for over twelve hours,  the employee is assumed to 
have left without signing out.  The computer will automatically change the IN remark to “?”
to express this ambiguity. 

Signing Out
To sign out, click on the remarks field adjacent to your name.  A pop-up list will appear.  
Click on the appropriate comment to assign it to the remarks field.

Some of the remarks contain “smart” fields which are identified inside {} or <> brackets.  
Remarks with the word “time”  in uppercase or lowercase inside {} brackets automatically 
insert the current time in the remark.  Prompts appear inside <> brackets.  Choosing a 
remark containing a prompt opens a window that will ask for information, such as a future 
date or time.    

If the remark you wish to insert is not available in the list, then you may enter a 
customized remark.  Click on <Custom Remark> and type your remark.  <Custom 
Remark> is a temporary remark.  If you wish to insert a permanent remark to the master 
list of remarks, use Add.  Remarks on the list may also be added and deleted using the 
procedure outlined in Modifying Master List of Remarks.

Choosing a sign-out remark turns off the highlight in your remarks field.

If you choose Sign Out on Exit in the Options menu, then whenever you turn off your 
computer when your remark is indicating IN, the remarks field will automatically change to 
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OUT.  The absence of a tick mark in front of this item indicates that this feature is turned 
off.  Clicking on Sign Out on Exit  toggles this feature on and off.

Changing Remarks on the Board
To change a remark, use the same procedure described in  Signing In or Signing Out.  
More detailed remarks can be inserted in the Additional Information screen.

Sending Messages
To send a message, click on the name of the person to whom you wish to send a 
message.  From the pop-up menu, select Send Message.  This action opens a dialogue 
box where you may type your message.  All the standard Windows editing features apply. 
If a phone message is to be sent, press on Phone Msg and type replies to the prompts for
the name and number.  Press Send to send the message and exit or press Cancel to 
delete the message and exit.

Reading Messages
A blue flashing background on your name indicates a new message has been received.  
To read your message, click on your name. From the pop-up menu, select Read 
Message.  This opens a dialogue box which displays a message as well as the date and 
time it was sent and the author.  You may click on the Erase button to delete the message
or click on Next to view the next message.  Messages which have not been read are 
colored green for the first viewing.  They will be colored black for any subsequent 
viewings.  Clicking on Erase will remove the message from the queue and bring up the 
next message.  Clicking on Erase All will erase all the messages in the queue.  Clicking 
on Close will exit you from the window.  Upon exiting the window, the background on your
name will no longer flash if you have read all your messages.

Enlarging or Reducing the OfficeView Screen
The OfficeView screen may be enlarged or reduced in steps of 60%.  The screen can be 
blown up so that it is visible from a distance.  To resize the screen, click on Options/Shrink
Screen or Options/Expand Screen.  You may find it more convenient to use F4 to shrink or
F5 to expand.

 Receiving a Message (Pop-up OfficeView)
If a new message is received when OfficeView is hidden by another program window or is 
in an icon state, it will pop-up in its normal size in front of all other windows.  The 
background of your name will flash and the Title Bar will blink  “MESSAGE”.   If you wish 
to continue your work, then minimize OfficeView.  If you wish to read your message, click 
on Options/Read  (or short-cut Ctl R).

If you choose to minimize OfficeView without reading your message, the text on the icon 
will blink “MESSAGE” to remind you that a new message was received. 
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Updating the Additional Information Window
To update the Additional Information window, click on your name and Information.  Add 
any desired information, e.g., telephone numbers, etc.  This screen can be viewed by any 
users.    

Password Access
A password system is available to control access to change some information.  
Specifically, this refers to  using the following commands: Add Name, Remove Name, My
Name, Add New Group, Rename Group, Delete Group and to changing information in 
other employees' Information windows.  

Most users operate in User Mode which prevents them from accidentally adding or 
removing names, etc. . Administrative mode permits access to use all commands.  To 
operate in Administrative Mode,  the Administrator(s) need only click on File/Admin Mode
and enter the password.  To disable Administrative Mode, click on File/User Mode.  The 
unregistered OfficeView defaults to Administrative Mode, permitting you to easily explore 
all the features.  The registered copy defaults to User Mode.

To change the password, click on File/Change Password and you will be prompted to 
enter the current password once, and the new password twice.  Passwords must consist 
only of letters.  The program will confirm that a new password has been accepted.
  
Initially, the security password is set to "abc".  When you register you will be given an 
additional emergency password.

Hiding the Yellow Pop-Up Help Hints
To prevent the yellow pop-up help hints from appearing, choose Yellow Hints under 
Options.  The absence of a tick mark in front of this item indicates that the hints are 
turned off.  Clicking on Yellow Hints toggles this feature on and off.

Hiding the Name Warning
The question,  "This is not your name.  Do you want to proceed?" appears when a user 
chooses a name other than his/her name.  To turn off this warning, choose Name 
Warning under Options.  The absence of a tick mark in front of this item indicates that 
the question is turned off.  Clicking on Name Warning  toggles this feature on and off.

Viewing a Group (Included in program for 1000 names)
To display an organizational group, select Group and the name of the group to display.

Searching for a Name (Included in program for 1000 names)
This feature provides a fast method to locate a name.  Type in the first few letters of the 
name.  As the name is typed, an alphabetical list of names will pop-up on the screen and 
the cursor will be automatically scrolled to the name with matching letters. Type Enter to 
switch to the group containing the name that is highligted.  This feature will search all 
names in the organization..
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3) MENU GUIDE

The command menus appear in the menu bar at the top of the OfficeView board.

File Menu

a) Load Standard Remarks
Overwrites the existing remarks with a set of standard default remarks.   This command 
can be used in cases where the remarks have been modified and the users wish to return 
to a standard set of remarks.  

b) Admin Mode
Enables the user to change the configuration. Specifically, this refers to modifying the 
following commands: Add Name, Remove Name,  My Name, Add New Group, Rename
Group, Delete Group and to the Additional Information screen for all employees.

Initially, the  password is set to "abc".

c) Change Password
Changes the password. You will be prompted to enter the current password once, and the
new password twice.  Passwords must consist only of letters.  The program will confirm 
that a new password has been accepted.

d) User Mode
Disables commands that allow  users to change the OfficeView configuration, i.e., add 
names, delete name, identify names, add group, rename group and delete group.

e) Add New Group (1000 names only)
This command is password protected. Refer to password access above. Choose this 
menu item to add a group.  A window will appear with the prompt "Enter New Group 
Name".  Type in the name and click on OK

f) Rename Group (1000 names only)
This command is password protected. Refer to password access above. To rename the 
title of a group, select the name of the group to be modified by clicking on Group and the 
choosing the name of the group.  This name should appear on the top bar of the screen.  
Then choose File and Rename Group.  A window will appear indicating "Enter New 
Name".  Type in the name and click on OK.

g) Delete Group (1000 names only)
This command is password protected. Refer to password access above. To delete a 
group and erase all the names in that group, select the name of the group to be modified 
by clicking on Group and the choosing the name of the group.  This name should appear 
on the top bar of the screen.  Then choose File and Delete Group.  A window will appear 
asking to confirm that the group should be deleted.  Click on Yes.
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h) Exit
Quits OfficeView.

Group Menu (Included in program for 1000 names)
Choose Group in the menu bar.   A list of organizational/group names will appear.  
Choose the desired group.  The screen will display the names in that group and the title 
bar will indicate the group name.

Options Menu

a) Read Message
Select this to read your messages.  

b) Add Name
Click on Add Name and type the name to be added.  Press Enter or OK  to enter the 
name or press Cancel to cancel the command.

c) Modify Remarks List
Click on Modify Remarks List to display a list of the remarks options. To add a new 
remark to the list, click on Add and type a remark into the field displayed in the dialog box 
that pops up.  To remove a remark from the list, highlight the remark to be deleted and 
click on Remove.  After making the modifications, click on Close to save the changes and
exit the window.

d) Shrink Window
Click on this to reduce the window to your preferred size.

e) Expand Window
Click on this to expand the window to your preferred size.

f) Yellow Hints
Click on this command to toggle the feature on and off.  When a tick mark appears on this 
menu item, then the yellow pop-up hints are activated.

g) Name Warning
Click on this command to toggle the feature on and off.  When a tick mark appears with 
this menu item, then the pop-up question window is activated.

h) Sign Out on Exit
Click on this command to toggle the feature on and off.  When a tick mark appears with 
this menu item, the program will automatically change your status from IN to OUT 
whenever you turn off your computer.
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Help Menu

a) Contents 
Click on Contents to launch the on-line help system.  Select a subject.

b) Topic Search
Click on Topic Search  to search for on-line help for a subject.  

c) About
Select this item to display a window containing buttons for registration and ordering 
information.  It also contains program information (e.g., registration and serial numbers).

4) ADMINISTRATION 

Unrestricted Access
OfficeView has a security system to control access to the configuration data.  Access to 
some commands/changes are only available to those who know the required password 
that will permit unrestricted access.  Specifically, this refers to modifying the following 
commands: Add Name, Remove Name, and My Name and to the Additional Information 
screen for all employees.  To turn off this restricted access feature so that all commands 
are available, the Administrator(s) need only click on File/Unrestricted Access and enter 
a password.  To activate the restricted commands, click on File/Restricted Access.

To change the password, click on File/Unrestricted Access and enter the current 
password followed immediately by “;” , the new password, a second “;”  and finally the new
password again.  For example, “abc;new;new” requests that the current password “abc” 
be changed to “new”.   The program will confirm that a new password has been accepted. 
Passwords must consist only of letters.

Adding New  Names
To add a new name to the display board, click on Add Name in the Options menu, type 
the new name, and choose OK or Enter.  The names are automatically displayed 
alphabetically.

Identifying Your  Name
The program must identify names with workstations in order to make the messaging 
system fully functional.  To do this, after a new name is added, at the appropriate 
workstation, click on the name to be associated with that workstation and select My Name
from the pop-up menu. The name will appear in the top title bar.  This procedure need 
never be repeated, unless a new user operates at that computer.

Removing Names
To remove a name, click on the name to be removed.  From the pop-up menu which 
appears, click on Remove Name and confirm the removal by choosing Yes.
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Maintaining the List of Remarks
The list of remarks is the list from which users may select a remark.  To modify this list,  
choose Modify Remarks List  in the Options menu.  A window containing the list of 
remarks will appear. This list may be updated using the three buttons that appear (Add, 
Remove, and Close).  To add a remark to the list, click on Add and type a remark. To 
remove a remark from the list, select the remark to be deleted and click on Remove. To 
close the pop-up window, click on Close.

Remarks can have a “smart”  field which prints the current time.  To add a remark with the
current time, insert the word “time” in uppercase or lowercase within {} brackets.  For 
instance, type “Left at {current time} “.  The current time will be printed in the remark when
the users choose it. 

A second type of field is the prompt field which requests the user to add information.  To 
add a prompt field to a remark, insert the prompt text within <> brackets. As an example, 
include  <date>  to prompt the user to enter a date.  

If  the master list of remarks becomes modified extensively and you wish to reset it to the 
original set of remarks provided by this program, choose File and Load Standard 
Remarks.

Phillips Software can customize the List of Standard Remarks to meet the specific needs 
of your business.

Adding a Group (Included in program for 1000 names)
To add the name of an organization/group, choose File and Add New Group.  A window 
will appear indicating "Enter New Group Name".  Type in the name and click OK.

Adding User Names to a Group (Included in program for 1000 names)
The group must be chosen before adding new users.  You must be viewing the group; that
is, the name of the group should appear in the top bar. The commands for adding users to
groups operates the same as outlined in Adding New  Names.

Renaming a Group (Included in program for 1000 names)
To rename an organizational group’s title, select the name of the group to be modified by 
clicking on Group and the name of the group.  This name will appear in the top bar of the 
screen.   Choose Options and Rename Group.   A window will appear indicating "Enter 
New Name".  Type in the name and click on OK.
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5) INSTALLATION 

The OfficeView program includes the following files:

1)   OV.exe main OfficeView program ( may be a similar name)
2)   Setup.exe program to install OfficeView
3)   Setup.inf  setup script needed for installation
4)   FILE_ID.DIZ brief program description
5)   OVhelp.hlp program help file
6)   Register.hlp help format registration instructions
7)   OVStdRem.ini standard remarks file
8)   OVState.bin state of the board binary file
9)   OVglobal.ini current remarks file
10)  Manual.doc program manual in Microsoft Word format
11) Meter.dll support program.
12) Readme.txt brief installation instructions

If you receive OfficeView in a compressed format, i.e., from the Internet or a CD library, 
then you will receive all the above files in one file called OVZIP.EXE (regular OfficeView) 
or 2OVZIP.EXE (group OfficeView).  

To extract and install OfficeView, click on the File menu of your Windows Program 
Manager, and select Run.  (Windows 95 users click Start/Run.) Type  OVZIP.EXE or 
2OVZIP.EXE and click on OK.   Click on Unzip to extract the files.  When prompted, run 
the setup program.

If you are starting from a distribution diskette, use Program Manager’s File/Run or the 
Task Bar Start/Run. Type in A:SETUP.EXE and click on OK.

The following opening screen of the Setup program will appear:

Single Workstation Install 
To install a single copy for one computer only, select Single Install.
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The following screen will appear:

Enter the directory where the main program will reside.  Click on OK to install the program
and files. The following screen will display:

In Windows 95, the following window will appear:

This completes the single computer installation.
The setup program creates a group called OfficeView, with an icon to start OfficeView and
a second icon to run the OfficeView Help.

For Windows 95, the OfficeView program will be added to the Windows 95 taskbar 
Start/Programs menu.

Network Installation
If more than one workstation will be using this program, then a single copy of  the program
must be installed on a shared directory.  This directory can be located on a fileserver or 
shared on a peer-to-peer LAN. 
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For workstations on a LAN or a common fileserver, select Network Install from the setup 
program’s opening screen and the following screen will appear:

The software should be installed in the common directory on the fileserver or shared 
directory first so that the setup program is available to all the attached workstations. To 
install OfficeView software on the common shared directory, select Server.  For a 
workstation, select Workstation to add a Program manager group and program Icons.  
The following screen will appear:

Enter the common shared directory (the drive letter may not be the same one very 
workstation) and click on OK.  The following screen will display:

13



In Windows 95, the following window will appear:

The OfficeView program will be added to the Windows 95 taskbar Start/Programs menu.  
For additional workstation installations, run the setup program from the common network 
directory and repeat the sequence.

Loading SHARE.EXE in CONFIG.SYS

If you are using Windows version 3.1, it is necessary to load the DOS SHARE.EXE 
program to install file sharing and locking capabilities on your system.  This feature is 
needed to prevent data loss when simultaneous changes are made. (If you are using 
Windows version 3.11 or greater, SHARE.EXE is installed automatically.)  To do this, 
include a line similar to the following in your CONFIG.SYS file:

INSTALL=C:\DOS\SHARE.EXE /F:4096 /L:500

The values you specify for the /F and /L options will depend on your system (see your 
DOS manual for details).

Removing OfficeView
The following steps outline how to completely remove the main copy of OfficeView. On 
LAN Workstations complete the first two steps only.

Delete:
1)OfficeView group and OfficeView icon from the Program Manager.
2)OVlocal.ini from the main windows directory (usually c:\windows).
3)all files in the OfficeView directory ( default directory c:\OView ).
4)OfficeView directory.
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6) FEEDBACK AND UPGRADES

We welcome any suggestions you have for improvements or upgrades or other 
information you may wish to communicate about this product.  Your comments will be 
considered in preparing any future upgrades.  You may contact the author via e-mail at 
phillips@capitalnet.com or OfficeView@ottawa.com. 

We are providing a five-name version of OfficeView for 10 or 30 users and a three-user in 
three groups version for the 1000 user program free of charge. To increase the number of
users, you must register your copy of OfficeView by purchasing the package, as outlined 
on the attached Order Form.

All registered users are entitled to e-mail support and free upgrades to the next release..

For the latest version, check our Internet Home Page at 
http://www.capitalnet.com/~phillips/.
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7) ORDER FORM 

Payments by check or money order (payable to Len Phillips) must be in U.S. or Canadian dollars.  All orders 
from outside Canada and the U.S. must be by check or money order.

Purchase orders (net 30 days) in U.S. or Canadian dollars are accepted only from government, accredited 
educational institutions and major corporations in Canada or the United States. 

Please mail this form with your payment or purchase order addressed to Len Phillips,  915 Plante Drive, 
Ottawa, Ontario, CANADA K1V 9E3. 

When you purchase this product, you will receive a diskette containing program files and an electronic 
version of the manual.  Written instructions will accompany the diskette.  In case you do not want to wait for 
the mailed version,  in addition, we e-mail a registered version to you.

OfficeView is shipped on 3.5 inch disks only.

Maximum Names Price Net
10 : (regular) $30.00 US   ( $39 Canadian) _____________
30 : (regular) $50.00 US   ($65 Canadian) _____________

1000 :  (group) $99.00 US  ($130 Canadian) _____________
Ontario residents add 7% provincial sales tax _____________

Canadian residents add 8% GST _____________
Shipping & handling add $4.00 (Can. or U.S.) _____________

Total Payment _____________

Name: _____________________________________________________________

Company: __________________________________________________________

Address: ___________________________________________________________

City: _______________________ State/Province: __________________________

Zip/Postal Code: __________________ Country: ___________________________

E-Mail Address: _____________________________________________________

__ 16-bit or __ 32-bit version 

OfficeView version #________________ __________________________________

Comments: _________________________________________________________
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8) FINE PRINT (LEGAL DISCLAIMER) 

While every effort has been made to make this document as accurate and helpful as 
possible, Len Phillips makes no warranty of any kind with regard to its content.  All 
information included herein is subject to change without notice.  Len Phillips and any 
associates are not responsible for any loss or damages, direct or indirect, arising from or 
related to the use of this product.

All rights reserved.  Reproduction, adaptation or translation without prior written 
permission is prohibited, except as allowed under copyright laws.
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